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9. Hinweise für Layout 
 

Vor dem Generieren eines Layouts sind in einem leeren Layoutfenster die Präferenzen einzustellen: 

Mit   Options  -->  Preferences  das Präferenzfenster öffnen. 

 

Typische Einstellungen: 

Tab Item Wert 

Grid/Snap Snap Grid Distance 0.1 

 Snap Grid Per Minor Display Grid 10 

 Snap Grid Per Major Display Grid 5 

Component Text Size 0.5 

Text Size 3 

Layout Units  Layout Units mm 

 Resolution 0.0001 

 

Elemente aus der „RF Transistor Library“, „RF Passiv SMT Library“, „HF Diode Library“ und zusätzlich ge-

ladenen Vendor Libraries (z.B. Murara, Coilcraft, etc.) enthalten auch die Layoutdaten. 

Schemaelemente aus den Komponentenpaletten „Lumped-With Artwork“ und alle planaren Leitungen 

(Microstrip, Stripline, etc.) enthalten ebenfalls Layoutdaten. 

Allen anderen Elementen kann explizit ein Layout zugeordnet werden. 

 

9.1. Komponenten aus der „Component Library“ 
 

Werden im Schema Komponenten aus  

 

RF Passiv SMT Library 

zusätzlich geladenen Vendor Libraries (z.B. Murara, Coilcraft, etc.) 

 

verwendet, enthalten sie auch die zugehörigen Layoutdaten und erzeugen im Layout die Solderpads und 

weitere Layoutelemente wie Lötstopmaske, Beschriftung, Gehäuse, etc. 

 

Damit die Solderpads im Layout richtig generiert werden, muss auf dem Schema für jedes Gehäuse ein 

„SMT_Pad“ eingefügt werden. 
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Die Solderpads müssen den Komponenten zugewiesen werden: 
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Für Komponenten aus  

 

RF Transistor Library 

HF Diode Library 

 

sind die Solderpads bereits definiert. Sie benötigen keine Definition in einem zusätzlichen „SMT_Pad“. 

 

Achtung: Überprüfen Sie die Anschlussreihenfolge bei Transistoren. Viele Transistoren werden mit ver-

schiedenen Anschlussreihenfolgen hergestellt. 

 

Schema Layout 

 

                 
 

 

Layerzuweisungen: 

 

Layer Bedeutung Layout 

 

 

Alle  

 

 
 

 

bond 

 

 

Solderpads 
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leads 

 

 

Elementanschlüsse 

 
 

 

packages 

 

 

Gehäuse 

 
 

 

ports 

 

 

Anschlusspunkte 

 
 

 

silk_screen 

 

 

Element-Nr. 

 
 

 

silk_screen2 

 

 

Elementbezeichnung 

 
 

 

solder_mask 

 

 

Lötstopmaske 

 
text  

Anschlussbezeichnungen,

(E,B,C, etc.) 

 sofern vorhanden 

 
 

 

9.2. Schemaelemente aus der Komponentenpalette „Lumped-With 
Artwork“ 

 

Diese Elemente enthalten nur die Lötpads (auf Layer cond) mit Anschluss auf der Aussenseite.  

Die Parameter W, L und S müssen direkt im Element eingegeben werden. 
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Gehäuse W (mm) L (mm) S (mm) 

0402 0.6 1.4 0.4 

0603 0.8 2.2 0.7 

0805 1.1 2.6 0.7 

1206 1.4 4.3 0.9 

 

9.3. Artworkzuweisung an beliebige Elemente 
 

Right click on Element 
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Fixed wählen 

 

 

Artwork auswählen 

 

 

Layout 
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9.4. Erstellung des Gerber-Files für die Printherstellung in unserem 
Labor 

 

Das Layout ist mit dem Umriss der Printgrenzen und geeigneten Beschriftungen zu versehen. Ausser-

halb der Printgrenzen können Printvermassungen, Substratinformationen und weitere Informationen 

eingefügt werden. 

Keine Umlaute verwenden, die 0 (Null) wird als durchgestrichene Null gedruckt, eventuell den Gross-

buchstaben O für die Null verwenden. 

 
Das Layout mit Beschriftung, Vermassung und PCB-Umriss ergänzen und Gerberfiles für Print-
herstellung erstellen.  

a) Zwei neue Layer („mechanical“ und „label“) erstellen.  

b) PCB-Umriss mit Polylinie auf Layer „mechanical:drawing“ zeichnen. 

c) Kommentar und Vermassung ausserhalb PCB, mit Insert>Text oder  auf Layer „text:drawing“, 
Texthöhe min. 1.5 mm. 

d) PCB-Beschriftung auf Layer „label.drawing“: Component-Palette: Block Text Fonts > sans, Text-
höhe min. 2.5 mm. 

e) Hintergrund für PCB-Beschriftung, Rectangle auf Layer „label.drawing“ zeichnen. 

f) Erstellung des Gerber Files für die Printherstellung. 
 

 

a) Zwei neue Layer erstellen mit den Bezeichnungen: 

„mechanical“: Printumriss 

„label“: Printbeschriftung 

 

In Layout-View: Options > Technology > Layer Definitions, dann „Add Layer / Display Property“ 

 

 

 

Die zwei neuen Layer mit den Na-

men 

„mechanical“ und   

„label“  

erstellen.  

 

Wichtig:  

Diese Reihenfolge einhalten. 

 

Alle Defaultvorgaben können über-

nommen werden. Die Layer erhalten 

automatisch die Nummern 39 bis 40. 
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Im Layer Definition-Fenster  „Color“, „Pattern“, „Shape Display“ und “Line Style” einstellen. Für den 

Layer “label” bei „Trans“ den Wert 128 einstellen 

 

 
 

mechanical

label

 

mechanical

label

 

label

 
Die Reihenfolge der Layer überprüfen. Mit dieser Reihenfolge wird sichergestellt, dass die Beschrif-

tung und die PCB-Umrisse nicht vom Beschriftungshintergrund verdeckt werden. 
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b) PCB-Umriss mit Polylinie auf Layer „mechanical:drawing“ zeichnen. 

Entlang dieser Polylinie wird der Print ausgefräst. 

 

c) Kommentare und Vermassungen ausserhalb PCB, mit Insert>Text oder  auf Layer 

„text:drawing“, Texthöhe min. 1.5 mm. 

Hier können Printvermassungen, Substratinformationen und weitere Informationen eingefügt wer-

den. Diese Angaben dienen für die Printherstellung, Bestückung, Betrieb oder Test. 

 

d) PCB-Beschriftung auf Layer „label.drawing“: Verwenden Sie dazu den Schrifttyp „sans“ aus der 

Palette „Block Text Fonts“.  Component-Palette: Block Text Fonts > sans,  

Texthöhe min. 2.5 mm 

Keine Umlaute verwenden, die 0 (Null) wird als durchgestrichene Null gedruckt, eventuell an Stel-

le den Grossbuchstaben O für die Null verwenden. 

Standardmässig werden die Prints im Labor mit „inverser“ Beschriftung gefertigt, das heisst der 

Beschriftungshintergrund gemäss e) verbleibt als Kupferfläche und die Schrift wird aus dieser Flä-

che ausgefräst. 

 

 

 
PCB-Beschriftung:  

Block Text Fonts > sans,  
Texthöhe min. 2.5 mm 
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e) Hintergrund für PCB-Beschriftung: Rectangle auf Layer „label.drawing“ zeichnen.  

 

Hintergrund für PCB-Beschriftung
Rectangle auf Layer „label“

PCB-Beschriftung
„sans“-Fonts auf Layer „label“

Texthöhe min. 2.5 mm

PCB-Umriss
Polylinie auf Layer „mechanical“

Die Hintergrund-Fläche bleibt als Kupfer bestehen, 
die gelbe Schrift wird ausgefräst.

Kommentar und Vermassungen

 
 

f) Erstellung des Gerber Files für die Printherstellung  

Im Layout „File    Export“ wählen. 
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More Options: 
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Das Drill-File wird nur erzeugt, wenn Durchplatierungen (Vias) auf dem Print vorhanden sind. 

 

 
 

 

 

Die Gerber-Files werden nach xxxx_wrk\mfg\... exportiert. Für jeden Layer wird ein File „layer.gbr“ erzeugt. 

 

Der Gerberviewer von ADS kann zum Betrachten von Gerberfiles auch eigenständig ohne ADS verwendet 

werden. Dabei ist im Installationsverzeichnis von ADS in \bin\viewer.exe zu starten. Die ADS-Lizenz wird 

nicht benötigt. 
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10. Workspace archivieren und unarchivieren  
 

Um ein Workspace von einem Computer zu einem anderen Computer zu transferieren oder als Anhang 

mit einem Mail zu versenden, kann ein komprimiertes Archiv erstellt werden. Archive in ADS haben die 

File-Erweiterung „7zap“. 

 

Archivieren und unarchivieren: 

Im Hauptfenster (Main) den entsprechenden Befehl wählen und dem Dialog folgen. 

 

 
 

Wichtig: 

Beim Archivieren darf das zu archivierende Workspace nicht geöffnet sein, sonst werden eventuell 

nicht alle im Worspacedirectory „data“ enthaltenen Datenfiles ins Archiv aufgenommen.   

 

Verloren gehen Datenfiles von EM-Simulationen und Datenfiles von Messungen mit dem Netzwerkanaly-

zer. Wenn aber das zu archivierende Workspace in ADS nicht geöffnet ist, werden scheinbar alle Files ar-

chiviert. 

Dieses Verhalten ist in ADS nicht dokumentiert. In gewissen Fällen kann es sinnvoll sein, sehr grosse Da-

tenfiles nicht ins Archiv zu übernehmen. In diesem Fall ist es empfehlenswert, das Workspace zu kopieren, 

die unerwünschten Files zu entfernen und anschliessend ein Archiv zu erstellen. 
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11. EM-Simulation von planaren Strukturen (z.B. Filter)  
 

Vorgehen: 

• Layout generieren 

• Im Layout Substrat definieren  

• EM-Simulation Setup:  

• Simulatorwahl 

• Substratauswahl 

• Frequenzplan definieren 

• Datasetname angeben 

• Mesh-Eigenschaften einstellen 

• Start der Simulation:  

 

Die einzelnen Schritte sind im Folgenden detailliert beschrieben. 

 

Layout generieren: 

Aus dem Schema wird das Layout mit  Layout  -->  Generate/Update Layout  erzeugt. 

 

Wichtig: Im Schema müssen Ports am Ein- und Ausgang vorhanden sein, damit diese im Layout auto-

matisch eingefügt werden. Die Ports können zwar auch im Layout nachträglich eingefügt wer-

den, nur sind dann einige wichtige Aspekte zu berücksichtigen (siehe Help). 

 

Port im Schema Port im Layout 
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Substrat definieren: 

Im Layout Substrateditor starten:  

 

 
 

 
 

 
 

In diesem Fenster können bei komplizierten Substraten die Werte aus der „MSub“-Anweisung im Schema 

geladen werden (File>Import>Substrate from Schematic). In vorliegendem Beispiel wird das Substrat ma-

nuell definiert. Detailinformationen zu den einzelnen Parameter und Verfahren sind im Help zu finden. 
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Mit Maus Groundplane selektieren. Parameter unverändert übernehmen. 

 
 

Dielektrikum anwählen. Dicke angeben. Material editieren. 
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Neu definiertes Material anwählen: 

 
 

Interface anwählen. Parameter unverändert übernehmen: 
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Layer „cond“ (Leiter) anwählen. Material definieren, Operation, Position und Dicke einstellen, Rauhigkeit 

definieren: 

 

 

 
Damit ist die Substratdefinition abgeschlossen. 
 
Hinweis:  Im Substrateditor kann auch mit File>Import>Substrate from Schematic die Substratdefiniti-

on aus der Substratanweisung im Schema übernommen werden. In der Version ADS 2011.10 
führt dies aber meistens zu einem Fehler in der Substratdefinition. 

Save Substrat . 
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EM-Simulation Setup:  

 

Zusammenfassung und Simulatorauswahl: 

 
Substratauswahl: 

 
 

Frequenzplan: 

 
Zum überprüfen der Simulationszeit Npts nur auf 2 einstellen. 
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Die Simulation mit Sweep Type Adaptive erzeugt zwei Datasets: 

Cellname_MomUW :   enthält die Daten für jeden simulierten Frequenzpunkt 

und  

Cellname_MomUW _a :   enthält interpolierte Daten (normalerweise im Datadisplay verwenden) 

 

Eventuell Dataset-Name ändern: 

 
Mesh-Eigenschaften einstellen: 

 
Mesh Density:  Für erste Kontrollsimulationen 15 bis 20 cells/wavelength verwenden, damit die Simulation 

nicht zu lange dauert. 

Für die genaue Simulation 35 bis 100 cells/wavelength verwenden. 
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Mesh berechnen: 

Nach Meshberechnung die Meshgrössen überprüfen und allenfalls Anzahl cells/wavelength anpassen. 

  
 

Die Parameter für die restlichen Felder (Options, Ports, Recources, Model/Symbol, Notes) können auf den 

Defaultwerten belassen werden. 

 

Start der Simulation:          

 

Nach Beendigung der Simulation wird ein Datadisplay mit vorgegebenem Template geöffnet, sofern diese 

Option eingeschaltet ist. 

 

Die Datenset können in normalen Datendisplays verwendet werden, z.B. zum Vergleich Simulation aus 

Schema mit Momentum-Simulation oder gemessenen Daten. 

 

Wichtige Hinweise: 

 

EM-Simulationen können je nach Rechner, Layoutstruktur und EM-Setup sehr lange dauern. Eine Probe-

simulation mit grobem Mesh (20 Cells/Wavelaength) und wenigen Frequenzpunkten wird zur Abschätzung 

der Simulationszeit empfohlen.  

Achten Sie darauf, dass keine unnötigen Elemente auf dem „cond“- oder „cond2“-Layer liegen und in der 

Simulation mitverwendet werden. Printbeschriftungen sollten so weit von relevanten Strukturen entfernt 

sein, dass sie keinen oder nur einen vernachlässigbaren Einfluss auf die EM-Felder haben. Beschriftungen 

nie auf den Layern „cond“ und „cond2“, sondern auf den Layern „text“ und „label“ platzieren (siehe 9.4 Er-

stellung des Gerber-Files für die Printherstellung in unserem Labor). 
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12. Co-Simulation, Schema- und EM-Simulation  
Schaltungen die sowohl Layout-Strukturen und konzentrierte oder aktive Elemente enthalten, können in 

einer Co-Simulation kombiniert werden. An der Layout-Struktur wird eine EM-Simulation durchgeführt und 

die EM-Daten im Schema zusammen mit anderen Elementen weiterverwendet.  

Das Vorgehen wird am Beispiel eines Wilkinson-Dividers veranschaulicht. Der Wilkinson-Divider besteht 

aus einer Leitungsstruktur und zwei Widerständen. Der konzentrierten Widerstände können nicht direkt im 

Layout eingefügt werden und in die EM-Simulation einbezogen werden. Aus der Layout-Struktur wird ein 

Mehrtor gebildet und für dieses Mehrtor die EM-Simulation durchgeführt. Das Mehrtor kann mit seinen S-

Parameterdaten aus der EM-Simulation im Schema wiederverwendet und mit weiteren Elementen be-

schaltet werden. 

 

Vorgehen: 

• Im Schema zusätzliche Ports für den Anschluss der Widerstände einfügen. 

 

 

 
• Widerstände im Schema deaktivieren und Layout generieren 
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• Im Layout werden die Ports an den Anschlussstellen der Widerstände eingefügt 

 

 
 

• Substrat definieren 

• EM Setup definieren. In Model/Symbol Einstellungen wie unten.  

 

Bestimmt Grösse des 
Symbols

 
 

• EM-Simulation durchführen 
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• Neues Schema (z.B. mit Cell Name „Co_Sim“) erstellen 

• Aus dem Hauptfenster das symbol_lookalike ins Schema ziehen 

 

 
 

• Widerstände im Schema einfügen (ideale Componenten oder Componenten aus Vendor Library) 

• S-Parameter-Terminations und Simulationsanweisung einfügen 

 
 

• Lookalike-Symbol im Schema selektieren und als View for Simulation das emModel auswählen 
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Nun kann im Schema die Simulation durchgeführt werden. Für die Layoutstruktur werden die Daten aus 

der EM-Simulation verwendet. Dabei wird im Schema die Layoutstruktur wie ein Mehrtor mit zugeordneten 

S-Parameterdaten aus der EM-Simulation behandelt. Die Simulation ist sehr schnell und erlaubt auch die 

Optimierung der passiven Elemente (Widerstände). 

 



 

  87 

 

 

13. Touchstone File schreiben  
 

Mit dem „Data File Tool“ können von bestehenden Datasets Touchstone Files geschrieben werden. Das 

Touchstone File kann z.B. in Smith zur Dimensionierung der Anpassungsnetzwerke weiter verwendet wer-

den. 

 

Vorgehen: 

• Gewünschte Schaltung simulieren 

• Im Schema Data File Tool starten:    Tools    Data File Tool 

• Einstellungen wie unten 

 

Das Touchstone Datenfile wird ins Directory „data“ des aktuellen ADS-Projektes geschrieben. 

Wenn in der Simulation die Option „Noise“ aktiviert war, werden die Rauschdaten ebenfalls ins Touchstone 

File geschrieben. 
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14. Messung mit VNA HP8753C und ADS  
 

Die Messplätze mit den vektoriellen Netzwerkanalysatoren HP 8753C sind über den HPIB-Bus (GPIB) mit 

den Rechnern verbunden, so dass die Messresultate direkt in ADS übernommen werden können. Dies 

erlaubt die Darstellung der Messresultate im Datadisplay von ADS und somit auch einen direkten Ver-

gleich der Simulations- und Messdaten. Für Dokumentationszwecke können die Grafiken aus ADS in 

Word-Dokumente kopiert werden. 

 

ADS ist ausschliesslich dafür eingerichtet, die Messwerte vom NWA zu lesen. Es ist nicht möglich, den 

VNA von ADS aus zu bedienen. Die gewünschte Messung inklusive Kalibrierung ist am VNA auszufüh-

ren. Anschliessend können die Messwerte von ADS eingelesen werden. 

 

Messung mit HP 8753C 

 

Einstellungen HP 8753: 

Gewünschten Frequenzbereich und Anzahl Datenpunkte vor der Kalibrierung einstellen. 

„Full 2-Port“ Kalibrierung durchführen. 

DUT messen 

 

Bedienung HP 8753C siehe Kurzanleitung oder Manual. 

 

Messdaten in ADS einlesen 

 

In ADS kann der Instrumentenserver in einem Schema gestartet werden mit: 

 

Tools > Instrument Server… 

 

Ablauf und Einstellungen: 

• Symbolic Name (GPIB) auf „gpib0“ einstellen        HP-IB > Sybolic Name (oder ctrl+S). 

• „READ“ und „Network Analyzer“ aktivieren. 

• HPIB-Adresse auf 16 einstellen (Der VNA ist normalerweise bereits auf diese Adresse eingestellt). 

• „FORMATTED“ und „ALL S PARAMETERS“ auswählen. 

• Dataset Name und Block Name eingeben 1) 

• Übertragung mit „Read Instrument“ starten. Im Meldefenster wird der Fortgang der Übertragung 

angezeigt. 

 
1)   Für jede Übertragung muss ein neuer Dataset Name und Block Name verwendet werden. 
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   gpib0 
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Von ADS aus hat man Zugriff auf die drei Datenarrays ‘Raw Data’, ‘Corrected Data’ und ‘Formatted Data’ 

des aktiven Darstellungskanals. 

 

„Raw Data Array“: Dieses enthält die effektiv gemessenen Werte. Ein eventuell aktiviertes 

Averaging ist wirksam. 

 

„Corrected Data Array“: Bei eingeschalteter Korrektur enthält dieses Array die kalibrierten Mess-

werte. Bei ausgeschalteter Korrektur gleicher Inhalt wie ‘Raw Data Array’. 

 

„Formatted Data Array“: Dieses Array beinhaltet die Messwerte, wie sie zur Bildschirmdarstellung 

gelangen. Ein aktiviertes Smoothing wirkt sich nur auf dieses Data Array 

aus. 

 

Die Datenarrays enthalten immer nur die Daten der gewählten Messfunktion (S11, S12, S21 oder S22). 

Eine Ausnahme bildet die Kalibrierart ‘Full 2-Port’. Bei dieser Betriebsart werden alle 4 S-Parameter ge-

messen, da sie zur Fehlerkorrektur benötigt werden. 

 

Das Dataset mit den gemessenen S-Parametern kann sowohl für Präsentationen (Data Display) als auch 

als Ein- oder Zweitor in S-Parameter-Simulationen (Schema) verwendet werden. 

 

Verwendung der gemessenen Daten im Data Display von ADS 

 

Das Dataset der gemessenen Daten wird im Ordner „data“ des aktuellen ADS-Projektes gespeichert und 

kann wie hier gezeigt im Datendisplay verwendet werden: 

 

Beim Einfügen von Daten in eine Graphik 

kann das Dataset mit den gemessenen 

Daten ausgewählt werden. 

 

 

 

  Gemessene Daten 

 

 

  Simulierte Daten 
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15. Messung mit VNA R&S ZVL oder ZVC und ADS  
 

Die Messplätze mit den vektoriellen Netzwerkanalysatoren R&S ZVL und ZVC sind über den HPIB-Bus 

(GPIB) mit den Rechnern verbunden, so dass die Messresultate direkt in ADS übernommen werden kön-

nen. Dies erlaubt die Darstellung der Messresultate im Datadisplay von ADS und somit auch einen direk-

ten Vergleich der Simulations- und Messdaten. Für Dokumentationszwecke können die Grafiken aus ADS 

in Word-Dokumente kopiert werden. 

 

Das R&S Interface RSADSIF muss auf dem Rechner installiert sein und in ADS als Design Kit integriert 

und aktiviert sein. Dies ist erkennbar am zusätzlichen Rohde & Schwarz - Menu in den Schemas des 

Workspaces 

 

  
 

und der zusätzlichen Rohde & Schwarz – Palette 

  
 

mit den Elementen  

 
 

Die Netzwerkanalyzer ZVL und ZVC werden durch die Elemente aus ADS gesteuert. Die Einstellungen am 

VNA (Vector Network Analyzer) wird dabei übersteuert. Der VNA wird also von ADS bedient. Die Kalib-

rierung des VNA ist vor der Messung auszuführen. Anschliessend können die Messungen aus ADS 

durchgeführt und in ADS eingelesen werden. 

Ist das Rohde & Schwarz – Menu nicht vorhanden, muss das Designkit von R&S in das Workspace einge-

bunden werden. Wenn auf dem Rechner des ZVL-Messplatzes ein neues Workspace in ADS erstellt wird, 

muss das RSADS-Designkit im New Workspace Wizard wie unten gezeigt aktiviert werden. 
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Wenn ein auf einem anderen Rechner erstelltes Workspace geöffnet wird, muss das R&S-Designkit zum 

Workspace hinzugefügt werden: 

 

 
 

 



 

  94 

 

 
 

 

15.1. Messung mit ZVL oder ZVC 
 

Einstellungen ZVL oder ZVC: 

Gewünschten Frequenzbereich und Anzahl Datenpunkte vor der Kalibrierung einstellen. 

„Full 2-Port“ Kalibrierung durchführen. 

DUT messen. 

Alle 4 S-Parameter müssen auf dem ZVL/ZVC-Display angezeigt werden. 

 

Bedienung ZVL und ZVC siehe Kurzanleitung oder Manual. 

ZVL:   Menu Trace --> Traces --> Add Trace 

 Trace durch anklicken von TrcX aktivieren und mit Trace --> Meas --> Sij S-Parameter zuordnen. 

 Wiederholen bis alle 4 S-Parameter einem Trace zugeordnet sind. 

 

15.2. Messungen mit ADS und Daten in ADS einlesen 
 

Ablauf und Einstellungen: 

 

• Im Rohde&Schwarz – Menu das RS ADS Interface öffnen und die Instrumenteneinstellungen prü-

fen (Label, Resource und Type). Allenfalls die GPIB-Adresse mit den Einstellungen der VNA über-

prüfen. Mit „Test“ kann die Kommunikation zwischen ADS und dem Messgerät geprüft werden.  
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• In ADS ein Schema mit der Komponente S2P aus der Rohde&Schwarz Palette erstellen. Es ist 

sinnvoll, der Zelle des Schemas einen Namen zu geben, der aussagt, dass es sich um Messdaten 

handelt, z.B. „Meas_1“. 

 

 

Die Frequenzwerte in der S-Parameter Simulationsanweisung und der Komponente RS S2P müs-

sen übereinstimmen. Variablen dürfen für die Zuweisung der Frequenzen nicht verwendet wer-

den. Die grösste Genauigkeit wird erreicht, wenn die Frequenzpunkte der Messung mit den Fre-

quenzpunkten der Kalibration übereinstimmen. Dies wird erreicht, wenn FreqStart, FreqStop und 

FreqStep bei der Messung gleich sind wie bei der Kalibration des VNA. Wir bei der Messung ein 

anderer Frequenzbereich oder FreqStep als bei der Kalibration verwendet, wird entweder zwi-

schen den Kalibrierpunkten interpoliert, oder die Kalibration ausgeschaltet. Unbedingt die Anzeige 

des Kalibrationszustandes auf dem Bildschirm des VNA beachten. 

Das Label der Komponente muss mit der Labelangabe im Interface übereinstimmen.  

Ausgangsleistung des VNA (RFLevel) und ZF-Bandbreite (IFFilter) des VNA werden ebenfalls in 

der Komponente angegeben. 

RunPreset=0, sonst wird die Kalibration ausgeschaltet. 

RFLevel=-10, minus 10 dBm zur Messung passiver Schaltungen, (bei höheren Pegelwerten ent-

steht eventuell zusätzlicher Ripple). 

 

• Messung im Rohde & Schwarz – Menu starten (Start Simulation) 

 
 

• Ablauf der Messung im Pop-up-Fenster beobachten 



 

  96 

 

• Nach der Messung wird automatisch ein Datadisplay mit den Messresultaten angezeigt (sofern 

das Display Template „S_Params_Quad_db_Smith“ oder ein anderes Display Template im Sche-

ma vorhanden ist). 

 

 
 

• Das Dataset, in diesem Beispiel „Meas_1.ds“, kann in anderen Datadisplays, z.B. zur gleichzeiti-

gen Darstellung der Simulations- und Messresultate, weiter verwendet werden. Dieses File kann 

mit dem Windows-Filebrowser in andere Workspaces kopiert werden. 
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16. Substrate for Microstriplines  
(and other planar lines) 

 
H =  substrate thickness, in specified units  

Er =  relative dielectric constant  

Mur =  relative permeability (1 for nonferrite) 

Cond =  conductor conductivity, in Siemens/meter 

Hu =  cover height, in specified units 

T =  conductor thickness, in specified units  

TanD =  dielectric loss tangent  

Rough =  conductor surface roughness,  
  in specified units; RMS value 

 

Conductivity: 
 
Copper 5.8e7 S/m 
Gold 4.5e7 S/m 
Silver 6.25e7 S/m 
Aluminium 3.6e7 S/m 
Brass MS58 1.7e7 S/m 
Brass MS63 1.4e7 S/m 

 
 

Cu Clad  Thickness 

oz/ft2 um  mil mm mil mm 

0.500 17.5  4 0.102 45 1.143 

1.000 35 (Standard)  5 0.127 50 1.270 

2.000 70  6.6 0.168 60 1.524 

   10 0.254 62 1.575 

Cu Surface Roughness:    15 0.381 75 1.905 

ED       2.4 um     19 0.483 93 2.362 

Rolled  1.4 um   20 0.508 100 2.540 

   25 0.635 125 3.175 

   30 0.762 187 4.750 

   31 0.787 250 6.350 

Standard       

   1 mil = 1/1000 inch = 25.4 um  
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Substrates on stock in lab T205 
 

  Type Er Er tan d Thickness Cu Clad 

Stock    Design 1 MHz /x GHz 10 GHz mil oz/ft2 

X FR4 4.70 0.0200    20, 31, 62 1 

X CER-10-0470-CH/CH 10.00     0.0035 47 0.5 

X CER-10-1250-CH/CH 10.00     0.0035 125 0.5 

X RF-35-0200-C1/C1 3.50  0.0018/1.9   20 1 

X RF-35-0200-CH/CH 3.50  0.0018/1.9   20 0.5 

X RF-35-0300-C1/C1 3.50  0.0018/1.9   30 1 

X RF-35-0300-C1/C1 3.50  0.0018/1.9   30 1 

X RF-35-0300-CH/CH 3.50  0.0018/1.9   30 0.5 

X RF-35-0600-C1/C1 3.50  0.0018/1.9   60 1 

X RF-60-0250-C1/C1 6.15     0.0028 25 1 

X TLC-32-0310-C1/C1 3.20 0.0010  0.0030 31 1 

X TLC-32-0310-CH/CH 3.20 0.0010  0.0030 31 0.5 

X TLC-32-0450-C1/C1 3.20 0.0010  0.0030 45 1 

X TLC-32-0600-C1/C1 3.20 0.0010  0.0030 60 1 

X TLC-32-1250-CH/CH 3.20 0.0010  0.0030 125 0.5 

X TLE-95-0052-C2/C2 3.00     0.0028 5.2 2 

X TLT-8 2.55 0.0006  0.0019 62 1 

X TLX-8-0200-CH/CH 2.55 0.0006  0.0019 20 0.5 

X TLX-8-0300-C1/C1 2.55 0.0006  0.0019 30 1 

X TLX-9-0050-CH/CH 2.50 0.0006  0.0019 5 0.5 

X TLY-5-0200-CH/CH 2.20 0.0004  0.0009 20 0.5 

X TLY-5-0620-RH/RH 2.20 0.0004  0.0009 62 0.5 

X TLY-5A-0200-CH/CH 2.17 0.0004  0.0009 20 0.5 

X RO 4350B 3.48 3.66    0.0031/2.5 0.0037 30 1 

X RO 4350B 3.48 3.66    0.0031/2.5 0.0037 60 1 

X RO 3006 6.15 6.48  0.0020 50 1 

X RO 3010 10.20 11.21  0.0023 50 1 

X RT/duroid 5880 2.20 2.20  0.0009 31 1 

X RT/duroid 5880 2.20 2.20  0.0009 62 1 

        

 Standard        
 
  Er Design: Für Mikrostrip- und Filteranwendungen 

 


